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Introduction

The Input/Output module centralizes the loading and saving of image data in Analyze 15.0. Input/Output supports the loading of 51 file

formats including standard Analyze file formats, common radiological and neurological formats, vender specific file formats, 2D desktop

publishing formats, and video

formats (see table on next page).

The Input/Output module has two
modes; Load mode and Save mode.
Load mode is the default mode

for the module while Save mode is
enabled when a data set is selected
in the workspace when Input/Output

is opened.

If a data set is selected in the
workspace when Input/Output is
opened the module will prompt you
to choose to start in Load mode or
Save mode. Selecting Yes, will start
the module in Save mode enabling

the saving of the selected image.

Analyze 15.0 User’s Guide

A EGV_MR - Input/Output

Input Process Output

Input Type: ®) Disk () Workspace () Database () Pacs

° @ v L3+ C:\ » Data » Tutorial Data »

[DAdditionalData

[ Colormaps

DImagePrncessmgTutﬂnal

[dmportExportTutorial

CIMultiSpectral Tutorial

[ Test_DICOM_Qutput

[(ATutorialData

[AVolumeToolTutorial

} AdjacentSections.avw

} AdjacentSlabs.avw
BeatVol.avw

[ BeatVol.obj

} Binary_CT_Brain.avw

j Canine_Chest_CT.avw

j Coronary_CT.avw

[ CT_Heart.avur

j CT_Liver.avw

} CT_Lungs.avw

[ CT_Lungs.obj

j Cubic_CT_Head.avw

j Cubic_CT_Head.obj

[ Edited_MRI_Head.avw

[ Edited_PET_Head.avw

[ EGV_CT.obj

[ EGV_MRIavw

} FatCells.avw

} FatCellsSeg.avw

[ Heart_Time_Paint_1.avw
j Heart_Time_Point_2.awvw
[ 1CH_CT.obj

j Mouse Sampled2.obj

} Mouse_Lungs_mCT.obj
[ MRI_3D_Brain.avw

[ MRI_3D_Brain.obj

[ MRI_3D_Brain_Bin.avw
[ MRI_3D_Head.avw

[ MRI_3D_Head.obj

[ MRI_Head.avw

[ MRI_T2.2vw

[ PET Head.avw

} Register_MRI_Base.avw
j Register_ MRI_Match.avw
SISCOM_lctal_SPECT.avw
j SISCOM_Interictal_SPECT.avw
[ SISCOM_MRLavw

[ SISCOM_MRI.abj

j Spinal_Cord.avw

j Splitting_Headache.avw
[ Thigh_MRlLavw

} Trans_Pre_OP_MRLavw

[ VH_Abdamen.avw

Load Yolume [ Info

Anterior

Posterior

Input/Cutput

Mo, start in
"Load" mode

An input data has been detected, do you wish to "Save" this input?

Yes, start in
"Save” mode

© AnalyzeDirect, Inc.
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@

File Formats and Attributes Supported by Analyze 15.0
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The Input/Output Window

The Input/Output windows consists of

the following nine sections:

1. Mode tabs: Allows user to select
the mode for the Input/Output

module from the following:

Input: Sets Input/Output to Load

mode for loading data into Analyze.

Process: Provides tools for processing
of image data, available for both load

and save modes.

Output: Sets Input/Output to Save
mode for exporting data from

Analyze.

A EGV_MRI - Input/Ouj
Input Process Output

Input Type: ®) Disk (O Workspace (O Database () Pacs E

° @ v (Z3r C\ r Data » Tutorial Data »

(D AdditionalData

(I Colormaps
Dlmager{essmgTutnnal
[(ImportExportTutorial
(CIMultiSpectralTutorial
[(0Test_DICOM_Output
(L1 TutorialData
[AvelumeToolTutorial
} AdjacentSections.avw
} AdjacentSlabs.avw
} BeatVol.avw

[ BeatVol.obj

[ Binary_CT_Brain.avw
} Canine_Chest_CT.awvw
} Coronary_CT.avw

} CT_Heart.awvw

} CT_Liver.avw

[ CT_Lungs.avw

} CT_Lungs.obj

[ Cubic_CT_Head.avw
} Cubic_CT_Head.ohj

[ Edited_MRI_Head.a

5] Emted_PET_Head.a:n
[ EGY_CT.obj

(™ EGV_MRLavw

} FatCells.avw
} F: g.avw

[ Heart_Time_Point_1.avw
j Heart_Time_Point_2.avw
[ 1CH_CT.obj

j Mouse Samplel2.obj

} Mouse_Lungs mCT.obj
j MRI_3D_Brain.avw

[ MRI_3D_Brain.obj

[ MRI_3D_Brain_Bin.avw
[ MRI_3D_Head.avw

[ MRI_2D_Head.obj

[ MRI_Head.avw

[ MRI_T2.avw

[ PET_Head.avw

j Register_MRI_Base.avw
} Register MRI_Match.avw
[ SISCOM_Ictal_SPECT.avw
j SISCOM_Interictal_SPECT.zvww
[ SISCOM_MRl.avw

[ SISCOM_MRl.obj

} Spinal_Cord.avw

j Splitting_Headache.avw
[ Thigh_MRlLavw

[ Trans_Pre_OP_MRl.avw

}VH_Abdomen‘avw

v Load/Save Prompt
Formats...

About...

Load Volume [ Info ﬂ

User Guide...
Get Help...

Anterior

2. Input Types: Select the location to load data from or save data to.

Disk: Allows data to be selected and loaded from the system'’s local disks or network drives.

Workspace: Allows data to be selected and loaded from a workspace.

Database: Allows DICOM data to be imported into a database, selected and loaded into Analyze. For Save mode allows DICOM data to be

stored in the database for export out of Analyze.

PACS: Allows for the configuration of Query/Retrieve (Q/R) of DICOM image data from PACS.

Analyze 15.0 User’s Guide
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3. Directory selector: Enables users to navigate to the location of the data to be
loaded.

4. File selection area: Allows users to select the desired data sets for loading.

5. Image display: Provides a display for data review of the selected image file prior to

loading.

6. Info option: When checked displays the header information for the selected file.
7. Right-mouse options:

Load/Save Prompt: Enable/Disable Load/Save Prompt (Figure 3.2)

Formats: Displays list of supported file formats and associated properties.

About - The About option opens the Analyze 15.0 About window. The About window
provides detailed information about the system and the Analyze software. Selecting

Done will close the About window.

User Guide - The User’s Guide option opens this User Guide.

Get Help - Directs you to the AnalyzeDirect website support pages.
8. Load Volume: Loads the selected file into the current workspace.

9. Exit: Closes the Input/Output module.

Analyze 15.0 User’s Guide

A Supported Formats - Input/Qu...  — O F
Properties
[] Read ] 2D [] Unsigned 8-bit [ ] Signed 2-bit
[] write 13D | Unsigned 16-bit | Signed 16-bit
[]4D [] Unsigned 32-bit [] Signed 32-bit
[] Float [] Double
] Complex
1 RGE
Formats

[ AnalyzeAVW [ ] UNKNOWN

[] OBIMAP

[11rG [] SunRaster
[ CTIECAT? (] GE9s00

[ GE Advantage [ ]| GESigna

] INTERFILE ] TIFF

[ PG L] PPMm

] xeMm O] PIC

[ SiermensCT ] SIEMENSMAGYIS
] ACRMEMA ] Dicom

] ANIMATEDGIF [[] PAPYRLUS2
[ SGirgb [ sGlbw

[ PostScript ] sMis

[ ¥xwD ] IMATROM
OJ QuickTimME - [ ITK

] MPEGT (] VARIANFDF
[] vox ] vsl

] Analyzelmage(7.5) | AnalyzeScreen

] avW_VelumeFile

C]cT

[ ] GEADVAMNCE
[] GESTARCAM
] PEM

[ ] TARGA

[] PICKERMRI
] vuv

[]GIF

[] PAPYRUS3
L] EMP

L[] PMNG

] BIORAD

] Av

L] MIFTI

Done
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Input: Loading Data

Loading a Single File from Disk

Input type: Disk

To load a single 2D image, a 3D
volume, or 4D multivolume into

Analyze:

Open Input/Output.

Navigate to the data [1] and select
the data set you want to load [2]. See
table at beginning of this chapter for

supported file formats.

Note that the data will be displayed.
(3]

Click Load Volume [4] to load the
data. The selected data set will be

loaded into Analyze 15.0.

Click Exit [5] to close Input/Output.

Analyze 15.0 User’s Guide

A CT_Liver - Input/Output

Input Process Qutput

Input Type: ® Disk O Workspace () Database () Pacs

©|/¢5 3/ (2 C Date » Tutorial Deta »

[JAdditionalData
[AcColormaps
[JImageProcessingTutorial
[AimportExportTutorial
[IMultiSpectralTutorial
[ATutorialData
[AVolumeToolTuterial
} AdjacentSections.avw
[ Adjacentslabs.avw
j BeatVol.avw

j BeatVol.ohj

j Binary_CT_Brain.avw
} Canine_Chest_CT.awvw
[ Coronary_CT.avw

j CT_Heart.avw
CT_Liver.avw

j CT_LuQavw

[4 CT_LurdR.obj

[ Cubic_CT_Head.avw
[ Cubic_CT_Head.obj
[ Edited_MRI_Head.avw
[ Edited_PET_Head.avw
[ EGV_CT.cbj

[ EGV_MRLavwr

j FatCells.avw

j FatCellsSeq.avw
ime_Point_1.avw

D Heart_Time_Point_2.avw

[ ICH_CT.obj

D Mouse Samplel2.obj

[ Mouse_Lungs_mCT.obj

[ MRI_3D_Brain.avw

[ MRI_3D_Brain.obj

[ MRI_3D_Brain_Bin.avw

[ MRI_3D_Head.avwv

[ MRI_3D_Head.abj

[ MRI_Head.avw

[ MRLT2Z.avw

[ PET_Head.avw

D Register MRI_Base.avw

[ Register MRI_Match.avw

[} SISCOM_lctal_SPECT.avw

D SISCOM_Interictal_SPECT.avw
[ SISCOM_MRlLavw
[ SISCOM_MRI.obj

[ Spinal_Cord.avw

B Splitting_Headache.avw
[ Thigh_MRl.avw

D Trans_Pre_OP_MRl.avw
D VH_Abdomen.avw

Load Volume [ Info

Anterior

Maw/Min 4 5 1

Exit
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Loading Multiple 2D DICOM Files as a 3D Volume from Disk

InPUt type: DiSk A Input/Qutput 15.0
Input Process Output Anterior
Input Type: @ Disk () Workspace (O Database () Pacs
To load multiple 2D DICOM files as 0/©) 4[> 01 Analyaebirects MicroCT» [1]
a single 3D volume from a folder (5t 20220905
T | 2 |
. o pen
on your system, Analyze provides e = -
elete
an InMemory DICOM Database
function. To generate the information
needed to provide the necessary
patient/study/series user interface for
selecting DICOM volumes, do the
following:
Open Input/Output.
Axial Slice = 1 Posterior
Lead Volume Info Exit

Navigate to the directory that
contains the DICOM image folder. [1]

NOTE: Do NOT navigate into a folder that contains the DICOM image files (.dcm files). In the example figure above, the directory to navigate
to is named “MicroCT", as this directory contains the DICOM image folders.

Next, perform a right-mouse click on a folder containing DICOM files (which in the example above is named “St_20221122") and select “Open
InMemory DICOM Database”. This quickly creates a temporary in-memory DICOM database which imports all the DICOM files found in the
folder selected, including subfolders within.

Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.
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Loading Multiple 2D DICOM Files as a 3D Volume from Disk (continued)

When the temporary in-memory
database is created, the input type is
automatically changed from Disk to
Database [3].

Once the process is complete, the
patient/study/series user interface is
displayed [4].

Any of the studies can be selected,
and the series contained within a
study will be displayed in the series
pane [5].

Click on the desired volume within

the series pane to see it displayed [6].

Al 16_5td20221212_Ser111712_V1 - Input/Qutput

Input Process Output
Input Type: O Disk (O Workspace (@) Database (O Pacs

3]

Database |InMemory Database -> (D:/AnalyzeDirect/MicroCT/5t_20221123) ~ | Impert Admin
Patient Name Patient ID Birth Date Gender
Mouse orientation tests 16 Dec 12, 2022

Study ID Study Date Time Modality Referring Phys Description
20221212 Dec 12, 2022 11:14:27.276  CT NA

20221212 Dec 12, 2022 11:14:27.276 cT MNA

221212 Dec 12, 2022 11:14:27.276 cT NA

20221212 Dec 12, 2022 M:1427.276  CT MA

. | [
Series |D Volume D Image Count Width Height Orientation  Description

111712 1 7 512 512 Axial

| [7]

With ring reduction.

[ Info

Load Velume

Anterior

Click Load Volume [7] to load the desired series into Analyze as a single 3D volume.

Click Exit [8] to close Input/Output.

NOTE: For importing and loading of 2D DICOM files using a persistent DICOM database (rather than the temporary in-memory

database method shown here), please refer to page 44.

Analyze 15.0 User’s Guide
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Loading Multiple 2D Non-DICOM Files as a 3D Volume from

Input type: Disk

Frequently, scanner vendors do not
support exporting data in a single 3D
format and choose instead to export
data as a series of 2D images such as
TIFF or BMP. To load a series of 2D
images into Analyze as a single 3D

volume:

Open Input/Output.

Navigate to the series of 2D image
files. [1]

To select a range of Image files, first

A TIFFO0 - Input/Output

Input Process Output

Input Type: @ Disk (O Workspace (0 Database () Pacs

° @ v (ZJ» €4\ + Data » Tutorial Data » VolumeTool Tutorial »

Y@=

[ TIFFo0DOAF [ TIFFO027.46F [ TIFFOOSA4.tif
[ TIFFoo01.t [ TIFFo0284iF [ TIFFO0SS.tif
[ TIFFoo02.tiF [ TIFFO029.46F [ TIFFDOSG.ti
[ TIFFo003.t% [ TIFFO0304iF  [*) TIFFO057.ti
[ TIFFoo04ti [ TIFFO031.4iF [ TIFFOOS8.tif
[ TIFFo00S.tF [ TIFFO032.4iF [ TIFFOOS9.tif
[ TIFFooD.tF [ TIFFO033.4iF [ TIFFO0SO.t
[ TIFFo007.4iF [ TIFFO034.4iF [ TIFFOO61.tif
[ TIFFoo02.ti [ TIFFO035.4iF  [%) TIFFOD62.tiF
[ TIFFoo09.t [ TIFFO036.4iF [ TIFFOO63.tiF
[ TIFFo0104F [ TIFFO037.6F [ TIFFOO64.ti
[ TIFFo011.6 [ TIFFO0384if [ TIFFO06S.tiF
[ TiFFo012.4 [ TIFFO039.46F  [™) TIFFOOB6.tF
[ TIFFo013.4% [ TIFFO040.4iF  [%) TIFFO067.tif
[ TIFFo0144% [ TIFFO041.4if [ TIFFOOB8.tF
[ TIFFO015.4F [ TIFFO042.4F [ TIFFO0G9.tiF
[ TIFFo016.4% [ TIFFO043.4iF [ TIFFOO70.ti
[ TIFFo017.4iF [ TIFFO044.6iF [ TIFFDO71.tif
[ TIFFoo12.4% [ TIFFO045.4iF [ TIFFOO72.ti¢
[ TIFFo019.4% [ TIFFO046.4F [ TIFFDO73.ti
[ TiFFo0204iF [ TIFFO047.4F [ TIFFOO7A.tF
[ TIFFo021.6 [ TIFFo0datif [ TIFFOO75.ti
[ TiFFo022.4iF [ TIFFOD4.6F [ TIFFOO76.ti
[ TIFFo023.4% [ TIFFO0S04iF  [*) TIFFOO77.ti
[ TIFFo024.4% [ TIFFOOS14iF [ TIFFOO78.ti
[ TIFFo025.4F [ TIFFO0S24iF [ TIFFOO79.ti

[™ TIFFO0B1.4if
[ TIFFO082.4if
[™ TIFFD083.4if
[ TIFFO084.tif
[ TIFFDOES.£if
[™ TIFFO0B6.4if
[ TIFFO0E7.4if
[™ TIFFD0S.4if
[ TIFFO089.4if
[ TIFFD0S0.tif
[™ TIFFO091 4if
[ TIFFO0S2.4if
[™ TIFFD093.4if
[ TIFF0094.tif
[ TIFFD0S5.tif
[ TIFFO096.4if
[ TIFFO0S7.4if
[ TIFFO092 4if
[ TIFFO099.4if
[ TIFFO100.4if
[ TIFFO101.4if
[ TIFFO102.4if
[ TIFFO103.4if
[ TIFFO104.tif
[ TIFFO105.4if
[ TIFFO106.4if

[ TIFFO107.4if

[ TIFFD108.4iF
[ TIFFO100.4F
[ TIFFOT10.4iF
[ TIFFO111 £if
O TIFFO112.tif
O TIFFO113.4if
[ TIFFOT144iF
[ TIFFD115.4iF
[ TIFFO116.tiF
O TIFFO17 i
[ TIFFO118.4iF
[ TIFFO119 8

120.tif

121 if

122 if
O TIFFO123.4if
[ TIFFO124.8if
[ TIFFD125.4if
[ TIFFO126.4iF
O TIFFD127 4if
[ TIFFO128.4if
[ TIFFO120.4F
[ TIFFD130.4iF
[ TIFFO131 £if
[ TIFFD132.tif
[ TIFFO133.4if
[ TIFFO134.4if

[ TIFFD135.tF
[ TIFFO136.tiF
[ TIFFD137.4iF
[ TIFFO138.4if
[ TIFFD130.tF
[ TIFFD140.tiF
[ TIFFO141.4if
[ TIFFD142.tF
[ TIFFO143.4if
[ TIFFD144.tif
[ TIFFD145.4iF
[ TIFFO145.tif
[ TIFFD147.tiF
[ TIFFO142.4if
[ TIFFD140.tif
[ TIFFD150.tiF
[ TIFFO151.4if
[ TIFFD152.tF
[ TIFFO152.4if
[ TIFFD154.tif
[ TIFFO155.4iF
[ TIFFO156.tiF
[ TIFFD157.tiF
[ TIFFO158.4if
[ TIFFD159.4F
[ TIFFO160.tF

[ TIFFO161.4if

Oy
O
By
Oy
B
By
O
By
Oy
B
By
O
By
Oy
B
By
O
By
Oy
B
Oy
O
By
Oy
O

i‘ﬁ.ﬁf [ TIFFO0S3.4f [ TIFFO0R0.tF

Load Volume] [ Info

Posterior

Exit

choose the first image in the series, then press the Shift key and finally select the last data set in the range [2]. Alternatively, select ctrl + a to

select all files in the directory.

By default, all selected images will be treated as a single volume [3]. Other load options, such as loading a series of 2D images individually, are

available from Process > Organize.

Click Load Volume [4] to load the data into the software as a single 3D volume.

Click Exit [5] to close Input/Output.

Analyze 15.0 User’s Guide
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Loading Multiple 3D Volumes from Disk

Input type: Disk

To load multiple 3-D volumes into the

program simultaneously:

Open Input/Output.

Navigate to the location of the image
data. [1].

To select multiple data sets, hold
down the Ctrl key and select each
data set to load. [2].

If the data select has different
properties (spatial dimensions,
volume sizes, data types, etc.) the
module will recognize this and

treat the selected data sets as
separate volumes [3]. Note that if the
properties of the selected data sets
are the same the module will default

to load as a single multivolume.

Click Load Volume to load all selected

volumes.

Click Exit to close the module [4].

Analyze 15.0 User’s Guide

/i EGV_MRI - Input/Output

Input Process Output

Input Type: @ Disk (O Workspace (0 Database () Pacs

° @ v (Z3» C\ » Data » Tutorial Data »

[ AdditionalData

I Colormaps

[(JImageProcessingTutorial

([ImportExportTutorial

[CIMultiSpectralTutorial

[ TutorialData

[ IVolumeToolTuterial

[ AdjacentSections.av

j AdjacentSlabs.avw
BeatVol.avw

} BeatVol.obj

} Binary_CT_Brain.avw

[ Canine_Chest_CT.avw

j Coronary_CT.avw

3 CT_Heart.avw

} CT_Liver.awvw

} CT_Lungs.avw

[ CT_Lungs.obj

[ Cubic_CT_Head.avw

[ Cubic_CT_Head.obj

[ Edited_MRI_Head.avw

[ Edited_PET Head.avw

[ EGV_CT.0bj

[ EGV_MRLavw

3 FatCells.avw

} FatCellsSeg.avw

} Heart_Time_Point_2.avw
[ ICH_CT.obj

[ Mouse SampleD2.abj
j Mouse_Lungs_mCT.obj
[ MRI_3D_Brain.avw

[ MRI_3D_Brain.obj

[ MRI_3D_Brain_Bin.avw
[ MRI_3D_Head.avw

[ MRI_3D_Head.obj

[ MRI_Head.avw

[ MRI_TZavw 2
[™ PET Head.avw

[ Register MRI| Nge.avwr

j Register MRI_Match.avw

[ SISCOM _Ictal_SPECT.avw

} SISCOM_Interictal_SPECT.avw
[ SISCOM_MRLavw

[ SISCOM_MRl.obj

j Spinal_Cord.avw

} Splitting_Headache.avw

[ Thigh_MRlLavw

} Trans_Pre_OP_MRl.avw

[ vH_Abdomen.avw

iﬁme}ointj‘avw

Load Volume [ Info

Posterior

Exit
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Loading Multiple 3D Volumes as a 4D Volume from Disk

Input type: Disk /i DTI_P1_B - Input/Output

Input Process Output & Anterior
e

Input Type: ® Disk (O Workspace Database () Pacs
Analyze 15.0 supports 4D image data ©/&ry Crchpats oMy ﬁ
y pp g [ DTI_P1_BO.avw
sets or multivolumes. Multivolumes -

[ DTI_P1_B3.avw

are data sets that that consist of D orosea
multiple 3D volumes. Multivolume h BEW
loading is automatically enabled
when loading multiple volumes that
have the same Voxel Dimensions and
Datatype. To load a series of volumes

as a multivolume:

Open Input/Output.
Navigate to the location of the image =n

data. [1] Load Volume| [ Info Bt

To select multiple data sets, hold
down the Ctrl key and select each
data set to load. [2].

As these data sets have the same
properties the module will default

to loading the data as a single
multivolume [3].

Click Load Volume to load all selected
volumes [4].

Click Exit to close the module [5].

Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.
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Loading Data From A Workspace

Input Type: Workspace

Input/Output supports the loading

of image data from one workspace

to another. To load data from a
workspace into the current workspace
(the workspace selected when Input/

Output was opened):

Open Input/Output.

Use the Workspace drop-down menu
to select a Workspace. [1].

Use the File drop-down menu to
select a data set [2].

The selected data to be previewed in
the Display window [3].

Click Load Volume to load the
selected file to the current workspace
[4].

Click Exit to close the module [5].

Analyze 15.0 User’s Guide

A 337_5td337_Ser102_V1 - Input/Output

Input Process OQutput
Input Type: ) Disk @ Workspace nabasa (O Pacs

Workspace | Workspace 1 ~
File|337 5td227 Sert02 1

-8

Toad Volume| [ Info

Anterior

Exit
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Loading DICOM Data from a Database

Input Type: Database 4 n e e

Input Process Output
Input Type: O Disk (O Workspace (®) Database () Pacs

The Database input option is for the

Databasel ~| |lmport| | Admin

|mport O‘F DICOM |mage da‘ta |nto Patient Name Patient ID Birth Date Gender
Analyze 15.0. The Database option

enables the indexing of collections

of DICOM images through a local SudylD  SwdyDse  Time W InputOutput
database -ﬁle To Create a database ? There is no input database connection. What would you like to do?
and for DICOM data import: I R

<

Series ID Volume D Image Count  Width Height Orientation Description

Open Input/Output.
Set Input Type to Database [1].

The first time the Database option is

selected, a window will be displayed,
Load Volume Info Exit

asking:

‘There is no input database

connection. What would you like to

do?’
Select Create a new database. [2].
Note: If you have used previous versions of Analyze or AnalyzePro and have created DICOM databases you can use the ‘Browse filesystem for an

input database’ to navigate to and select a .adb file. If this window is not returned or if this is not the first time you have opened the Database

option, select Admin button [3] to open the Administer Databases window and create a new database.
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Loading DICOM Data from a Database (continued)

The Administer Database(s) window Administer Database(s) B

will open.
Create Database

Name the database [3] and set the
location where the database will be Configure Database

saved. [4].
Delete Database

Database Name Analyzel

| Database Directory| |C:\Databases
DICOM Communication () Enable (@ Di
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Loading DICOM Data from a Database (continued)

Enabling DICOM Communications
(optional)

A DICOM receiver can be configured
for the database. The receiver will
run as a Windows service or Unix
daemon and will actively listen on

a specified port for DICOM image
data to be pushed to it from PACS or
any other DICOM node. To set up a
DICOM receiver:

Set the DICOM Communication to
Enable. [5].

Set the Port number [6] and
Application Entity Title (AET) Name.
[7]

Administer Database(s)

Database Name |Ana|}vze

Create Database
Configure Database

Delete Database

Database Directory | Ch\Databases

DICOM Communication (®) Enable 5 able
Receiver/STORESCP

(6

Note that the AET Name should not go over 16 alphanumeric characters.

Create‘h

Make a note of the Port number and AET Name. Your PACS administrator will need this information along with the systems IP address to

configure DICOM push from PACS.

Once configured on PACS you will be able to push DICOM image data from PACS to the Analyze 15.0 database. Note that if DICOM data is

not being received after pushing from PACS you may need to open the port number for the Receiver on your system’s firewall.

Click Create. [8].

Analyze 15.0 User’s Guide
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Loading DICOM Data from a Database (continued) A

For Windows users an informational
window will be returned informing
your that a system prompt will follow
to install services for the database.
Click OK. [9]

In the Windows User Account Control
prompt returned click Yes [10] to allow
the program to install the receiver

service.

Dismiss the service installed
confirmation message by clicking OK
[11].

Details about the receiver, as well
as the associated database server,
configured for the database are
displayed at the bottom of the
Administer Database(s) window [12].

Close the window.

Analyze 15.0 User’s Guide

ChDatabases\Analyze.adb

o A system prompt will follow to install services far

& User Account Control X

Do you want to allow this app to make changes to your

PC?

Program name:  Windows Command Processor
Venified publisher: Microsoft Windows

Show details Ves %

o Services installed for Ch\Databases\Analyze.adb

m

A
Administer Database(s) n
Analyze (C:\Databases)
Create Databaze
Cenfigure Database

Delete Databaze

Database Mame: Analyze

Database Directory: C:\Databases 1 2
Database Status: Exists Receiver(Analyze 8838,3838 Up) DB Server(Analyze_8339 Up) Log
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Loading DICOM Data from a Database (continued)

Importing Images

Once the Database is configured you
can now start importing DICOM image
data.

Click the Import button [13] or right-
click in the window and select Import
DICOM Images. [14]

Use the Directory Selector to navigate
to the location of the DICOM images to
import and click OK. [15]

A window will open stating Import
all DICOM files found below <the
specified folder>; click Yes. [16]

Analyze 15.0 User’s Guide

A Input/Qutput
Input Process Output
Input Type: O Disk O Workspace @ iDatabase O Pacs

Database |C:\Databases\Analyze.adb | import
Patient Name Patient ID Birth Date Gender
Refresh
Auto Refresh ’
Configure Columns
Configure Filt
StudyID  Study Date Time Mg -onrgurebier Description
v Show Datsbase Info
e
Update DB
< >
SerieslD  VolumelD ImegeCount Width  Height  Orientation  Description
Load Volume Info

Axial Slice = 1

Anterior

Import Dicom Images

Directory Selector

Please choose a directory, then select OK,

r’-;'.‘:ji;\

C

Look in:

(21 Image Data 4 @
[JDIcom

< >
Folder name:

C:\Data\Image Data\DICOMY

oK h Cancel

A Import Dicom Images

Import all DICOM files found below < C\Data\Tutorial

Data\DICOM Data\>

es ‘R Mo
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Loading DICOM Data from a Database (continued)

Loading DICOM Images

Once import is complete, the
image data will be available in the

database.

To load a DICOM volume, select the
desired patient, study and series

volume to see it displayed.

Click Load Volume [17] to load the

desired series into Analyze 15.0.

NOTE: To load multiple 2D DICOM
images as a 3D volume without
using a persistent DICOM database,

please refer to page 39.

Analyze 15.0 User’s Guide

o |
Input Process Qutput
Input Type: O Disk O Workspace (®) Database (O Pacs

Database | Ci/Databases/Analyze.adb

| import | Admin

Series D VolumelD  Image Count  Width Height
256

200 2 18 256 256

Patient Name Patient ID Birth Date Gender
MR SIGNA CONTOUR 0.5T 1 NA F

MR SIGNA LX 1.0T 337 NA F

MR SIGMA LX 1.0T 930 NA F

MR SIGMA LX 1.5T 28 NA o}

MR SIGMA PROFILE 0.2T 93 M

MR dataset Brain reg2 Jan 01, 1911 M
ULTRASOUND GE 000-00-0000 NA F
Study ID ~  Study Date Time Modality  Referring Phys Description

11 Apr 02, 1997 13:57:45 MR MELOFF e+1 MR BRAIN

< >

Orientation Description
Axial C5,1,4.5,0.7,1.1,0.85,108
Axial €5,1,4.5,0.7,1.1,0.85,103

7]

Load Vo\umh [ Info

Anterior

Posterior

Exit
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Loading DICOM Data from a PACS

Input Type: PACS

The PACS Input Type option allows
users to configure Query and Retrieval
of DICOM data from PACS. To set up
communications to allow Query and
Retrieval of DICOM data from PACS,
first create a database, see previous
section: Importing DICOM Data >
Creating a Database, then:

Remote AET Configuration
Open Input/Output.

Set Input Type to PACS [1]. Under
Remote AET, click Edit [2]. In the
Input/Ouput Administer PACS (AET)

list window that opens, click New [3]

The window will update showing AET,
System, Port, and Description fields.
Enter the PACS information into these
fields [4] and click Apply [5].

Note that you will need to contact
your PACS administrator to obtain the

relevant PACS information.

Analyze 15.0 User’s Guide

A
Input Process Output

Input Type: O Disk (O Workspace () Database (®) Pacs n

Remote AET

PACS/AET | v Edit...
Query/Return AET

LAPTOP-LBTHHAH2 MOVESCU  System LAPTOP-LBTHHAHZ  Port 10002 Properties..
Query

values Input/Qutput Administer PACS (AET) list
Patient ID Patient Name

Study Date
Find Clear

Patients

Mame [}
Save Apply
Patient Stud: Series Volume
Retrieve [ Info
Input/Qutput Administer PACS (AET) list n
Mew
Edit
Delete
ping
AET Systermn Port Description
[RADPACS | [127.004 | [104 | [Radiology PACS

Save

Cancel
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Loading DICOM Data from a PACS (continued)

The window will update and the PACS
information will be available in the main

window. [6].
Click Save to close the window [7].
Local Query/Retrieve AET Configuration

For Analyze 15.0 to successfully query and
retrieve DICOM image data from PACS
a local MOVESCU service needs to be

configured.

Under Query/Return AET click the
Propertied button. [8]

In the window returned enter the Q/R AET.

Note: The AET should not be over 16

alphanumeric characters.

Enter the Port number Q/R will use and
then click Apply. [10]

Make a note of the Q/R AET and Port
number. Your PACS administrator will need
this information along with the systems IP
address to configure Q/R on PACS.

PACS is now configured on Analyze 15.0.

Analyze 15.0 User’s Guide

Input/Cutput Administer PACS (AET) list

RADPACS (Radiclogy PACS)

1 Apply
2\
Input |Process Output

Input Type: (O Disk (O Workspace (O Database @) Pacs

e

Edit

Delete

Ping

Cancel

Remote AET

PACS/AET ‘ RADPACS

ke Edit...

Query/Return AET

LAPTOP-LBTHHAH2 MOVESCU  System LAPTOP-LBTHHAHZ  Port 10002

i B =
values

System |LAPTOP-LBTHHAH2

Find Port (10002
Patients Apply 10 el

Name ID DOoB

Patient Study Series Volume

Properties...

Gender

Retrieve Info

Note: There may be additional
configuration required on the
PACS side by your PACS admin.
Also, your systems Firewall may
need to be configured to allow
Inbound and Outbound commu-
nication for the Remote AET port
and local Query/Return AET port
prior to successful Q/R of DICOM
image data from PACS.

Anterior

Exit

© AnalyzeDirect, Inc.



INPUT/OUTPUT > LOADING DATA > LOADING DATA FROM A PACS

Loading DICOM Data from a PACS (continued)

Note: There may be additional configuration required on the PACS side by your PACS admin. Also, your systems firewall may need to be

configured to allow Inbound and Outbound communication for the Remote AET port and local Query/Return AET port prior to successful
Q/R of DICOM image data from PACS.

Querying and Retrieving DICOM data from PACS

To Query PACS, choose which PACS to query using the drop-down menu under Remote AET [1]. Under Query enter the Patient ID, Patient
Name or Study Date [2] and click Find [3]. The relevant patient data will displayed under Patients. [4].

Select the patient and click Retrieve/Load Volume(s) [5] to load the selected data into the current workspace.

4 Input/Output

Input Process Output
Input Type: (O Disk () Workspace () Database @) Pacs

Remote AET

PACS/AET ‘ RADPACS

Query/Return AET

AnalyzeOR  System LAPTOP-LBTHHAHZ  Port 10002

Query 2
values

Patient D | 1000335 Patient Mame |loe Bloggs
Study Date
Find Clear
Patients
Name [} DOB

Patient Study Series Volume

2

Properties...

Gender

Retrieve/Load Volume(s) [ Info

Input Anterior
ur Qutput Warkspace File)

Axial Slice = 1

Analyze 15.0 User’s Guide
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Process: Transforming Data

Spatial- and intensity-based transformations can be applied to the data while loading to or saving from Analyze 15.0. These

transformation options are available from Input/Output > Process, once a data set is selected.

Organize

MultiVolume Override

Sometimes image data may not be organized as expected. For example, two 3D data sets may be concatenated into a single 3D data
set, requiring the data to be split into two volumes. Furthermore, the data may be interleaved. The MultiVolume Override options

provide a utility to efficiently reorganize such problematic data while loading.
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Organize (continued)

* Open the Input/Output module.

Download the Neuro_Interleaved_T1_2_MRI

¢ Navigate to the data and select data set to follow along
http://analyzedirect.com/data/

the data set you want to load and
transform.

e Note that the data will be

Anterior
LT

disp|ayed [1] Organize ||ntensities Flip/Shift ' Subregion  Resize Pad/Orient
W MultiVolume Override
ation: |1 Volume of 34 Slices (Same as Dizabled)

¢ Select the Process tab [2].
* Under Organize, check the

Interleave 1 Volume of 34 Slices (Same as Disabled)
. . . Volumes of 27 Slices n
MultiVolume Override option. [3] # Volumes of 18 Shices 148

. . . & Volumes of 9 Slices
All possible data reorganization 9 Volumes of & Shoes
18 Volumes of 3 Slices
27 Volumes of 2 Slices

3 Volumes of 1 Slice

options will be available from the

drop-down menu.

We know that in this example the
54-slice data set is comprised of a T1
and a T2 data set, each containing 27
slices. Select the appropriate option
from the drop-down menu: 2 Volumes
of 27 Slices [4].

Posterior

Load Volume [] Infe
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Organize (continued)

® The data has now been changed

from a single 3D data set Input| Process Qutput

Anterior

containing 54 slices to a 4D Organize | Intensities | Flip/Shift | Subregion | Resize | Pad/Orient
W MultiVolume Override

multivolume made up of two o _
Organization: |2 Volumes of 27 Slices

3D data sets, each containing eteauc]

27 slices. Hold the cursor E

over the image and use the

middle mouse wheel to scroll

through the data. Note that

in this example, the T1 and T2

image data is interleaved so the

current volume will alternate

between T1 and T2 slices.

e To correct for the interleaved

! 5 Posterior
image data, check the E— .

Interleaved option [5]. s vo'“”ﬁ; L] info

e Scroll through the image data for
volume 1. This will now display
only the T1 image data.

* Use the Volume option [6] to
change to volume 2 and scroll
through the data. Only T2 image
data will be displayed.

e Click Load Volume [7] to load

the corrected image data.
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Intensities

The Intensities option allows for intensity scaling or threshold-based manipulations to be applied to the data.
Intensity Scaling

Intensity scaling allows for the adjustment of the voxel value information in the data. Image data can be scaled by adjusting the output Data

Type. Values can also be linearly scaled using the Input Maximum and Minimum scale options.
Modifying Image Data Type

Changing the image data type can reduce the size of the data on disk. In this example, a microCT data set has a data type of Float. The size
of the image data when loaded into AnalyzePro is 92.71 MB. Changing the data type to Signed 16-bit reduces the size of the data set by
about 50% to 46.35 MB when loaded.
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Intensities (continued)

* Open Input/Output.

¢ Navigate to and select the

data set you wish to load
and transform.

e Select Process [1] and Intensities
[2].

* Make a note of the Input
Maximum and Minimum values
[3].

e Select Load Volume. [4]. This
will load the volume to the

workspace as a Float data set.

Analyze 15.0 User’s Guide

Input? Process |

Download the Bone_Sample_mCT
data set to follow along
http://analyzedirect.com/data/

| Flip/Shift ’ Subregicn .:: Resize__i: Pad{Orient_i

12

(®) Intensity Scale () Threshold

| Minimum Input (DataType=Float) Masxirmurm |

62, 3] L 212207,

Output DataType; Float
Maximurn 12297.46 |
Minimum | -6442,03

[] Inwvert

Colormap

4

"Load ‘u":}lumst3 [] Info

Anterior

Posterior
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Intensities (continued)

* Set the Output DataType to
Signed 16-bit [S]. Input Process -Oyt_;.::u]::;. Anterior
e Enter the Output Maximum and | Organize, Intensities |Flip/Shift | Subregion | Resize | Pad/Orient

Minimum values [6] by copying ®) Intensity Scale ) Threshold

the input maximum and minimum | Minimurm Input (DataType=Float) Maximumf:

-2 3| L #1207, ||

values and rounding to the

nearest whole number. Output DataType Signed 16-bit “
Maximumn |~ 12297 5
Minimum|  -5442
Create New when prompted.

P P [ Inwvert

e Exit Input/Output [8].

e Select Load Volume [7] and select

Colormap

Posterior
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Intensities (continued)

e Right-click on the first data set
and select Info [9]. Repeat for the
second data set.

* In the info panel beneath the
data, note the size of the original

and scaled data set.

Analyze 15.0 User’s Guide

Unload...
Rename..
Edit Header...
Duplicate...

Append...
Un-append...

Select All
Invert Selected

Bone_Sample_mCTO

Bone_Sample_mC

FileName=C:‘\temp\APRO\Michael\Bone Sample mCT.mmap
DataType=AVN FLOAT (32-bit float)

Width=120
Height=208
Depth=615

NumVols=1
Size=92.71 Mb

Info:
0002|0002="1.2.840.10008.5.1.4.1.1.2"
0002 |0003="2.16.756.5.23.5050.67.3003.3.2014
0002|0010="1.2.840.10008.1.2.1"
0002 |0012="2.16.756.5.23.1.2"
0002|0013="5CANCO V1.2a"
0008 | 0008="0RIGINALYPRIMARY\AXTAT™
0008|001e="1.2.840.10008.5.1.4.1.1.2"
0008 |0018="2.16.756.5.23.5050.67.3003.3.2014
0008 |0020="20140107T"
0008|0021="20140107T"
0008|0023="20140107T"

FileName=C:‘\temp'\APRO\Michael\Bone Sample mCTO0.mmap
DataType=AVW SIGNED SHORT (l6-bit signed)

Widch=130
Height=208
Depth=615

HumWVols=1
Size=46.35 Mb

Info:
0002 |0002="1.2.840.10008.5.1.4.1.1.2"
0002 |0003="2.16.756.5.23.5050.67.3003.3.2014
0002 |0010="1.2.840.10008.1.2.1"
0002 |0012="2.16.756.5.23.1.2"
0002 |0013="5CANCC V1.2a"
0008 | 0008="CRIGINALYPRIMARY\AXTAL"
0008|0016="1.2.840.10008.5.1.4.1.1.2"
0008|0018="2.16.756.5.23.5050.67.3003.3.2014
0008 |0020="20140107"
0008 |0021="20140107"
0008|0023="20140107"
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Intensities (continued)

Threshold Scaling

Threshold scaling allows a range of

voxels from the input volume to be

Download the EGV_Post_Op_CT
data set to follow along
http://analyzedirect.com/data/

loaded as a binary data set. All voxels
greater than or equal to the Input
Minimum and less than or equal to the
Input Maximum are set to 1. All other

voxels are set to 0.

* Open Input/Output.

¢ Navigate to and select the data
set to which you want to apply a
threshold scaling.

e Select Process [1] and
Intensities. [2].

¢ Check the Threshold option [3].

* Use the Input sliders to set

the threshold minimum and

maximum [4].

g EGV_Post_Op_CT - Input/Output

Input Process 1
Organize| Intensities Ehiﬂ: Subregicn | Resize | Pad/Orient

@ (®) Threshold

() Intensity Scale

Minirmum Input (DataType=>Signed 16-bit) Maximurn
2003 i E 2{1500
Output DataType Unsigned 2-bit
Maximurn 1
Minirmum 0

[ Inwert

Colormap

a

Load Volumk [] Info

Anterior

Posterior

Exit

* Note the image display will
update, showing a binary image
for the selected voxels [5].

e Click Load Volume [6] to load the

binary volume.

Analyze 15.0 User’s Guide
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Intensities (continued)

Inverting Data —
Download the EGV_Pre_Op_MRI
I data set to follow along
For certain applications, such as the http://analyzedirect.com/data/
segmentation of the thalamus, it is

beneficial to view an inverted copy of

A

Flip/Shift | Subregion | Resize | Pad/Orient

the image data alongside the original

grayscale data to improve visualization ® Intensity| 2 o
of the thalamus. Reviewing the original RN ot DTS 16671 i
and inverted image data aids with 11

manual delineation of the structure. O onc 161
Maximurn 766

Minimum 0

* Open Input/Output.

* Navigate to and select the data

set you want to invert.

* Select Process [1] and Intensity [2]. I Coternai

e Select Load Volume [3] to load the
data into Analyze.

* Next, check the Invert option [4].
Note that the display of the data

will update [5].

e Click Load Volume [3] and select

Create New.

A grayscale and inverted version of the
data are now available for use within the
program. These two data sets can be

simultaneously loaded into Segment.
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Intensities (continued)

Colormaps

When loading a data set that has an

Download the Neuro_PET
data set to follow along
http://analyzedirect.com/data/

associated colormap [1], the Colormap

checkbox will be selected [2].

ey Neuro_PET - Input/Qutput
Input| Process | Qutput Anterior
Organize Flip/Shift | Subregion | Resize | Pad/QOrient
(®) Intensity Scale () Threshold
Minirmum Input (DataType=Unsigned 8-hit) Maximurn
o[l [ |=]2ss
Output DataType | Unsigned 8-bit v
Maximurn 255
Minimurn ]

[ Inwvert

@ Colormap

Posterior

Load Volume [] Info

Analyze 15.0 User’s Guide
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Intensities (continued)

* To load the grayscale data
without the associated .lkup
colormap file, uncheck the

Colormap checkbox [3]

Note that the image display will
update to show the grayscale data [4].

¢ To load the data, click Load
Volume [5].

Analyze 15.0 User’s Guide

Input| Process | Qutput Anterior

Organize| Intensities | Flip/Shift | Subregion | Resize | Pad/Qrient
(®) Intensity Scale () Threshold

Maxirmum

| %235

Minirmum

0]

Input (DataType=Unsigned 8-bit)

Output DataType Unsigned 8-bit  w
Maximurm 255

Minirmum 0

[ Invert

[3]%

Paosterior

(5]

Load Volume

[] Info
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Intensities (continued)

Standard Uptake Value Conversion A 1210089_5td 1324313 _Ser]_V1 - Input/ Qutput
Input Process Output Anterior
Organize Orient | ES Flip/Shift Subregion Resize Pad
The Standard Uptake Value (SUV) (O Intensity Scale O Threshold (® SUV Conversion n
in PET data is defined as the ratio AcqTme [ 09567700 (Hhmmssss)
o . . - Dose Start Time | 090500.00|(hhmmss.ss)
of activity in tissue per millimeter to Half Lie o308 seconds
L. . L. Body Weight 34|Kg
the activity in the injected dose per TowlDose  [116.13372 (@ M8q O mC
. . Output Max/Min = 11.8154/0.0000
patient body weight. When PET data o .
nvert
is loaded into Analyze via the Input/ —
Output Database a new Intensity
option ‘SUV Conversion’ appears,
[1] the scale factors present in the
DICOM header information with the
PET data are used to automatically
scale the data into units of activity
per millimeter. [2] Any sampling of the LoadVolume| [ Info Bt

PET data conducted in Analyze, such
as ROl analysis, will provide values in

this calibrated range.
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Flip/Shift

Data Flippin
pp 9 Download the EGV_Pre_Op_MRI
data set to follow along

It may be necessary to ﬂlp data in http://analyzedirect.com/data/

order to orient it correctly. The Flip/

Shift > Flip options allow users to Axis OUTCOME

flip data along any single axis or X Flips data horizontally, rotating about the vertical (Y) axis.

combination of axes. Y Flips data vertically, rotating about the horizontal (X) axis.
pA Changes the order of the slice data.

Once a flip checkbox is selected, the

flip will be applied to the data and the

display panel can be used to review. J s
Unchecking the option WI” undo the Organize Irjtensities% f't Subregion Resize. Pad/Qrient
Flip @ Shift
flip. Flipping the data in only the X or gi Ho:z:::ta: E o
. . . . . Ercica
Y direction will create a mirror image. Oz o
If this is not the desired result, the X 0

Y 0

data can be flipped in both the X
and Y directions at once to prevent a

mirror image from being created. To
apply a flip:
* Open Input/Output.

¢ Navigate to and select the data set

to be flipped and loaded.

e Select Process [1] and Aodal Slice = 100 Posterior
F|Ip/Shlft [2]. Load Volume [ | Info
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Flip/Shift (continued)

* Check the X Flip option [3].

Note the update to the data [4]. Input Process |Qutput Anterior
Organize | Intensities| Flip/Shift | Subregion | Resize | Pad/Orient
Flip Shift
X E Hor|zor_1ta| 0 Wrap
vy Vertical 0
z Shear Factor (per Slice)
X 0
Y 0

Posterior

Load Volume [] Info

Analyze 15.0 User’s Guide © AnalyzeDirect, Inc.



INPUT/OUTPUT > TRANSFORMING DATA

Flip/Shift (continued)

* Check the Y Flip option [5].
Note the update to the data [6].

¢ To load the data, click the Load
Volume button [7].

Analyze 15.0 User’s Guide

Input| Process |Qutput Anterior
Organize | Intensities| Flip/Shift | Subregion | Resize | Pad/Orient
Flip
X Horizor?tal 0 Wrap
Y Vertical 0
[z

Shift

Shear Factor (per Slice)
X 0
Y 0

Load Volume [] Info
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Results of Flipping Data Along Any Combination of Axes

Flip 2D 3D Flip 2D
N O Anterior Anterior
flip

X Anterior ‘ Anterior
Y Anterior

Z Anterior Anterior
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Flip/Shift (continued)

Shifting Data

Download the Neuro_MRI_Sagittal
data set to follow along

The shift option allows data to be http://analyzedirect.com/data/

shifted horizontally or vertically. Data

shift may be necessary to correct for
Superior

slice wraparound. In this example, the

front slices of a sagittally-acquired Flip Shift
Ll x Horizontal 0
MRI data set have wrapped around to Ov GE:C; 5 4 Wrap
the posterior side of the data set [1]. Oz Shear Factor (per Slice)
) ) ) x| 0
and there are slices from the inferior & =

side of the volume that have wrapped
around to the superior side of the

volume [2].

Load Volume [] Info
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Flip/Shift (continued)

e To correct for the horizontal
shift in slices, enter -25 in the
Horizontal Shift field [3].

Note that the data will be shifted

back 25 slices. The last 25 slices will
automatically wrap around from the
posterior side of the data set to the

anterior side of the data set [4].

e To correct for the vertical shift

in slices, enter 6 in the Vertical

Shift field [5].

Note that the data will be shifted up
6 slices. The top 6 superior slices will
automatically wrap around to the

inferior side of the data set, since the
Wrap checkbox is checked [6].

Analyze 15.0 User’s Guide

Input| Process | Qutput

Organize | Intensities| Flip/Shift | Subregion | Resize | Pad/Orient

3

| Wrap

5

Flip
Ox
O
Oz

Load Velume

[] Info

Shift
Horizontal -25

Wertical ]

Shear Factor (pen

X 0
Y 0

Superior

© AnalyzeDirect, Inc.



INPUT/OUTPUT > TRANSFORMING DATA

Shift Options Quick Reference

Shift Axial Coronal Sagittal
Horizontal + To left To left To anterior
Horizontal - To right To right To posterior
Vertical + To anterior To superior To superior
Vertical - To posterior To inferior To inferior

Analyze 15.0 User’s Guide
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Flip/Shift (continued)

e To shift data interactively, click
on the image data. Note that the

cursor will update; drag the data
to a new location [7].

Analyze 15.0 User’s Guide

Input| Process | Qutput

Organize | Intensities| Flip/Shift | Subregion | Resize | Pad/Orient

Flip
Ox
O
Oz

Load Volume [] Info

Shift
Horizontal
Wertical

-53
Wra
30 e

Shear Factor (per Slice)
X 0
Y 0

Superior

Inferior
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Flip/Shift (continued)

* Unchecking the Wrap checkbox

[8] will prevent slices from being

wrapped. [9].

Input| Process | Qutput

Organize | Intensities| Flip/Shift | Subregion | Resize | Pad/Orient

Flip
Ox
O
Oz

Load Velume

Analyze 15.0 User’s Guide

Shift
Horizontal -33
Vertical 30
Shear Factor (per Slice)
X 0
Y 0
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Inferior
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Flip/Shift (continued)

Shear Factor Correction

Sometimes CT images are acquired with the gantry tilted obliquely (non-orthogonally) relative to the direction of the table movement. If the
volume is constructed by stacking the image slices, the volume will appear sheared or skewed. Analyze will automatically detect and apply
the gantry tilt shear correction and the appropriate shear factor values will be populated in Shear Factor (per slice) fields. If desired, the

Shear Factor (per slice) values can be manually entered.
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Subregion

Cropping Data

The Subregion tool in Input/Output > Process can be used to reduce the size of a data set without the need to interpolate the original voxel

data. The tool can also be used to crop data to a specific region of interest.
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Subregion (continued)

* Open Input/Output.

e Navigate to and select the data
set you want to crop.

e Select Process [1] and Subregion
[2].

* To crop the data, click on the
green box [3] in the display
panel and adjust to the desired
position.

* To define the crop in the Z
range, click on the Slice option
[4]. With the left mouse button
held down, move the mouse up
or down to navigate through the
slice data. You can also use the
scroll wheel to move through the
slice data. When you reach the
lower limit for the crop, enter the
slice number in the Z Low box
[5]. Enter the upper limit slice
number in the Z High box.

e Click Load Volume to load the
cropped data [6].

Analyze 15.0 User’s Guide

Download the Neuro_ACPC_Aligned_MRI
data set to follow along
http://analyzedirect.com/data/

Organize | Intensities | Flip/Shift| Subregion @ Pad/Qrient

Low Inc High MNum
51 146 96
58 161 104
125 4
1 1

Aute Crop Image Auto Crop All

(6]

Load Volume [] Info

Anterior

Posterior
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Cropping 4D Data

4D image data can also be cropped
to remove time points from the data
prior to loading. When a 4D data

set is selected, a fourth dimension V
(volume) will be enabled [7]. To crop a
4D data set:

* Select the Volume option [7]
and use the cursor to navigate
through the volumes in the data,
just like you would use the Slice
option to navigate through the
slices in a single volume.

* Determine the volumes you want
to remove from the multivolume
and enter the corresponding
lower and upper volume limits in
the V Low and/or V High boxes
[8].

Analyze 15.0 User’s Guide

Download the 4D_Cardiac_CT
data set to follow along
http://analyzedirect.com/data/

|Input| Process | Qutput|

a zei Intensities E_FI_iE.’Shiﬂ:_i Subregion EResizei Pad/Orient |

Inc

;Auto Crop Imagei EAuto Crop ‘u"olumeg iAuto Crop All |

Posterior

{Load Volume | [] Info
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Resize

Resize can be used to resample
Download the Neuro_MRI_Sagittal

image data. If data is acquired with data set to follow along
http://analyzedirect.com/data/

anisotropic (non-cubic) voxels, resize

can be used to resample the data to

create an isotropic (cubic) data set. Superior
Organize | Intensities | Flip/Shift | Subregion Resize, 2
Resampling Anisotropic Data Input Output
Axis Voxel Voxel Axis
e Open Input/Output. DI il :
] X[ 256 09800 03800
¢ Navigate to and select the data Y[~ 2% 0.9800 10,9800

= - ]

set to be resampled. S 15000 250
Memory| 7.69/Mb 7.69 Mb

[] Force Cubic
e Click Load Volume [3] to load the Interpolation Linear (ID)

e Select Process [1] and Resize [2].

i F
i Eyﬁ_ﬁ
oy —

o= = m o+

data set without resampling.

ol

I
|

3

Load Volume [ Info
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Resize (continued)

e Check the Force Cubic checkbox
4].

Note the input and output voxel

size and the input and output axis
dimensions [5]. The data has been
resampled at the highest spatial
resolution (0.98). The Z dimension
which originally had a voxel size of

1.5 has now been resliced to 0.98. To
accommodate this, the number of
slices in the Z dimension has increased
from 123 to 188 (123*1.5/0.98 = 188).

* The interpolation option used to
create the new slice data can be
selected from the interpolation

drop-down menu [6].

For information about various

interpolation types, see Table 3.4 or 6.1.

¢ Click Load Volume [7] and select
Create New. Compare both the
original and resampled data sets

using Display.

Analyze 15.0 User’s Guide

Input| Process | Qutput
Organize | Intensities | Flip/Shift | Subregion| Resize |Pad/Orient
Input Output

Axis Voxel Voxel
5| Dim. Size Size
o e __
¥[ 2% 09200 | 0.9800
z[ 123 1.5000|
Memory|  7.69|Mb 1175 Mb
4

Interpolation Linear (D)

Superior

. D v
<" -
o
e

Sagittal Slice = 62 SAterior
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Resize (continued)

Each interpolation type is either input driven (ID) or output driven (OD).

Input driven interpolation algorithms process each voxel in the input volume and map each input voxel into the output space. The actual
interpolation takes place in the output space, given the projected contributions of each input voxel into that space. Input driven algorithms

will always use every voxel in the input volume as part of the interpolation process.

Output driven algorithms step through each voxel in the output data set and find the corresponding set of voxels in the input data set that
map into the output. The interpolation of voxels takes place in the input space, depending on the type of interpolation selected. Output
driven algorithms are more common in image processing as they guarantee that every voxel in the output data set will be filled with an

interpolated value.

Interpolation Types

Interpolation Type Description
Nearest Neighbor* selects the value of the closest voxel to which the interpolation resampling maps
Linear* applies a linear interpolation of grayscale intensity based on the distance of neighboring voxels from the

interpolated voxel

Cubic Spline** uses a cubic spline function to determine interpolated value
Windowed Sinc** uses windowed sinc function sin(x)/x to determine interpolated value
Shape Based only available for binary data; calculates Euclidean distance, then performs linear interpolation between

distance images

*The Nearest Neighbor and Linear interpolation types can be specified as ID or OD.

**The Cubic Spline and Windowed Sinc interpolation types are both OD. Since they use higher-order functions, they account for more neighboring voxels and thus may provide a better
estimate for the interpolated value. These algorithms are also more compute-intensive.
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Pad/Orient

Padding Data

Download the Neuro_MRI_Sagittal
data set to follow along
http://analyzedirect.com/data/

The Pad/Orient option can be used

to pad image data. This may be

necessary to create a data set with

Superior
certain dimensions or to make a data Organize | Intensities | Flip/Shift | Subregion | Resize| Pad/Orient 2
. | . I b f Pad Crientation
set isovolumetric (equal number o Low High Input|Sagittal
slices in each orientation). 0 0 _
Y| 0o 0 NOTE: Refermatting occurs
z[ ol o during Processing only and
° Open Input/Output. - has no effect on the
) L] Equal Padding interactive display.
¢ Navigate to and select the data Pad Value 0
Padded
set to be padded. Volume ~( 201" 20/ 188)
e Select Process [1] and Pad/Orient
(2]

* Note the slice dimensions for the
data are reported in the Padded
Volume fields [3].
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Pad/Orient (continued)

¢ To make the data set

isovolumetric, update the Input| Precess | Output E Superior
appropriate Padded Volume fleld Organize | Intensities | Flip/Shift | Subregion | Resize PadIOrie.nt .
Pad COrientation
[4]. The Pad tool will try to apply Low High Input|Sagittal
x| o o
an equal number of slices to pad v o o NOTE: Reformatting occurs
during Processing only and
. . z 34 34
the data in the pad axis [5]. . has no effect on the
[] Equal Padding interactive display.
* Users can also choose to pad all Pad Value 0
. . . Padded _
slices to either the Low or High Volume =(L 238jx| 256)x| 256)

field for the appropriate axis.
¢ Click Load Volume [6] to load
the data.

L
n Y
u
o
‘4

B
:

oy W

6 J§ 5agittal Slice = 129 : 5 meriln:n r

Load ‘u’olumem [ Info
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Pad/Orient (continued)

Correcting an Orientation Flag
Download the Neuro_MRI_Incorrect_Orientation

data set to follow along

If a data set is loaded with an http://analyzedirect.com/data/

incorrect orientation flag, it will not

orient correctly in other AnalyzePro

Anterior
modules. The Orientation option can Organize | Intensities | Flip/Shift | Subregion | Resize| Pad/Orient! 2
. Pad Orientation
be used to correct thIS. Low High Input| Transverse
x of o
* Open Input/Output. v of o NOTE: Reformatting occurs
. z ol o during Processing only and
¢ Navigate to and select the data : has no effect on the
[ Equal Padding interactive display.
set to be padded. Pad Value|0
Padded
e Select Process [1] and Pad/ inbmeatl Z0I8| 2608 1254

Orient [2].

Note that the orientation of this
sagittally-acquired data set is marked

as axial. [3].

Load Volume [] Info
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Pad/Orient (continued)

e To correct this, set the Orientation
Input option to Sagittal [4].

e Note that the axis labels in the
preview are corrected [5].

e Click Load Volume [6] to load the
data.

Analyze 15.0 User’s Guide

Input| Process | Qutput

Organize | Intensities | Flip/Shift | Subregion | Resize| Pad/Orient

Pad
Low High
X 0 0
¥ 0 0
Zl 0 o0
[] Equal Padding
Pad Value 0

Padded

Vol =(|_256]x| 256[x|_123])

6
Load ‘u’olumih [ Info

Orientation

NOTE: Reformatting occurs
during Processing only and
has no effect on the
interactive display.
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Output: Saving Data

Data can be exported from Analyze
15.0 as easily as it can be loaded
into the program Input/Output will An input data has been detected, do you wish to "Save” this input?

open in Save mode when a data set is

No, start in Ves, startin
selected. "Load" mode _5ave” mode

Opening Input/Output
in Save Mode

* Select a data set and open Input/
Output.

* A window will open, prompting
you to open in Load or Save

mode. Select Save mode.
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Saving a Data Set

* Input/Output will open with Output selected and the Output Type set to Disk [1].

* Choose to save the data as a 3D Volume [2] (default) or as multiple 2D images. The selection will determine the formats you can select

for saving the data.

e Use Directory [3] to select the location where you will be saving the data.

e Use File [4] to rename the data.

* Use Format [5] to specify the file format for the saved data.

e Select Save Volume to save the data.

P

EGV_Post Op_CT - Input/Output

Input | Process) Qutput 1
Output Type: () Preview (®) Disk

() Workspace () Database () Pacs

Volume Saving

(® Save As a 3-D Volume IZI

() Save As Multiple 2-D Images

File EGV_Post_Op_CT.aww

Format| AnalyzeAWVW

[5]

Calculate Max/Min

L4

Directory || C:/AnalyzePro_Resources/Data IEI

[4]

[] Compress

6
Save ‘u‘u:ulurneh [] Info
il

Anterior

Axial Slice =138 Paosterniar

Exit
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Storing Data in a Database

* Select the Database option [1].
¢ If required, select a database from the drop-down [2].
e Click Store Volume [3].

= EGV_Post_Op_CT - Input/Output
Input | Process Output Anterior
Output Type: () Preview () Disk () Workspa| 1 |(® Database () Pacs
Database |C:/Databases/AnalyzePro.adb Iz‘ v | | Admin
Patient Mame Patient ID Birth Date Gender
ME SIGHNA CONTOUR 0.5T 1 A F
MR SIGMA L 1.0T 337 A F
MR SIGMA L 1.0T 930 A F
MR SIGMA L 1.5T 28 A ]
ME SIGMNA PROFILE 0.2T 93 A M
Loial Slice =138 Posterior Mlaw/Min
131
Store ‘-.n‘u::lur’malb [] Info Exit
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Storing Data in a Database (continued)

* The Edit/Add DICOM tags
window will open. Use this tool
to add or edit any DICOM tag Edit DICOM tags

information. Patient

* Click Apply Tags and Continue [4]. ID (0010,0020) 500
Mame (0010,0010) Joe Bloggs
DOEB (0010,0030)
Gender (0010, 00407 (M

* The data will be exported to and

merged into the database.

Study

ID (0020,0010)
Description (0003,1030)
Date (D00E,0020)
Accession (0008,0050)
Medalty (0002,0060)
Portion (0008,0015)
(D020,000d) Make Mew Study Instance UID

Series

ID (0020,0011)|
Orientation |® Axial () Coronal () Sagittal
Description (0008,103€)

Procname (0008,1030)
(0020,000e) Make Mew Series Instance UID

Other Tags

(gggg,eces) |
4

|Appl)rTagsandCuntinue| | Clear | ‘ Add Tag | | Cancel ‘
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Sending Data to PACS

e Right-click on the data to send to PACS [5].
e Select Send Patient [6] and choose the PACS AET where you want to send the data [7].
e To configure PACS, see Configuring PACS Communications.

= EGV_Post_Op_CT - Input/Output

Input | Process| Output Anterior

Output Type: () Preview () Disk () Workspace (@ Database () Pacs

Database |C:/Databases/AnalyzePro.adb W Admin
Patient Mame Patient ID Birth Date Gender
loe Bloggs 500 — —

MR SIGNA CONTOUR 0.5 1 Refresh

MR SIGMA LY 1.0T 337 Configure Columns

MR SIGNA LX1.0T 930 Configure Filter

MR SIGMA LK 1.5T 28

v Show Database Info
Delete Patient

Anonymize Patient...

MR SIGMA PROFILE 0.2T 93

Import Dicom lmages
Update DB

Export F'atient

B

BAxial Shice =938 Posterior

Store Volume [ ] Info Exit
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